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Radio and television interference 
Thie equipment described in this manual generates, uses, and radiates radio­
frequency energy. If it is not installed and used properly-that is, in strict 
accordance with the instructions in this manual-it may cause interference with 
radio communication. 

This equipment has been tested and found to comply with the limits for a Class A 
computing device in accordance with the specifications in Subpart] of Part 15 of 
FCC rules. These specifications are designed to provide reasonable protection 
against such interference when the equipment is operated in a commercial 
environment. 

Operation of this equipment in a residential area is likely to cause interference, in 
which case the user, at the user's own expense, will be required to take whatever 
measures may be necessary to correct the interference. 

6 Important This product was tested for FCC compliance under conditions that included the 
use of shielded cables and connectors between system components according to 
the standards for RG-62 cables. It is important that you use coaxial cables and 
connectors to reduce the possibility of causing interference to radios, television sets, 
and other electronic devices. For Apple peripheral devices, you can obtain the 
proper shielded cables from your authorized Apple dealer. For non-Apple® 
peripheral devices, contact the manufacturer or dealer for assistance. 6 



p R E F A c E 

About This Guide 

USER'S GUIDE TELLS YOU HOW TO INSTALL AND USE THE MACDFT™ 

application. MacDFT enables your Macintosh® II computer to emulate the 

IBM family of 3270 terminals. This guide also explains how to install the 

Apple® Coax/fwinax card. 

xiii 



What you need to know 

To use this manual successfully, you should be familiar with the operation of 
your Macintosh II computer. For example, you should feel comfortable using 
the mouse and desktop. If you have just received your Macintosh II 
equipment and have never used a Macintosh before, check your owner's guide 
for information on setting up and using the Macintosh. 

6 Important When you're setting up your new Macintosh equipment, you can save 
yourself a step by installing the Coax/Twinax card at the same time that you 
install the video card. Follow the video card installation directions in your 
Macintosh owner's guide to install the Coax/Twinax card. Installation 
procedures for the Coax/Twinax card are also included in Chapter 2 of this 
guide. 6 

xiv Preface: About This Guide 

What's covered in this guide 

Here's a description of what you'll learn in each chapter. Note that the 
chapters should be read in consecutive order, since each chapter builds on 
concepts presented in the preceding chapter. 

• Chapter 1, "Introducing MacDFT," describes the features of MacDFT and 
tells you what you'll need to get started. 

• Chapter 2, "Setting Up MacDFT, "explains how to install your 
Coax/Twinax card, attach the coaxial cable, and install the MacDFT 
software. 

• Chapter 3, "Configuring MacDFT," explains how to configure MacDFT 
and save your configuration choices in a MacDFT configuration 
document. 

• Chapter 4, "Communicating With a Host," discusses how to launch and 
operate the MacDFT application. 

• Chapter 5, "Using the Keyboard and Keypad," addresses how to 
customize your keyboard and keypad for terminal emulation sessions. 

• Chapter 6, "Transferring Files," describes file transfer between the 
Macintosh and the IBM host. 



The appendixes contain valuable information: 

• Appendix A, "Reading the Status Line," describes some of the status line 
messages that you'll see when using MacDFT. 

• Appendix B, "MacDFT Error Messages," describes error messages 
generated by MacDFT and suggests possible solutions to problems. 

• Appendix C, "Supported Environments," lists the terminals that MacDFT 
emulates, host connections, and other features supported by MacDFT. 

The glossary at the end of this manual includes Macintosh-related terms and 
other computer terms that you might find helpful. New terms are presented 
in boldface type and are usually defined in the text. All terms that appear in 
boldface are defined in the Glossary. 

Terminology and conventions 

This section explains terminology used in this manual and shows some of the 
conventions used to highlight information. 

Macintosh II 

The term Macintosh II is used to refer to all Macintosh II computers, 
including the Macintosh Ilx and the Macintosh Hex computers. 

3270 

The term 3270 is used to refer to the family of IBM Information Display 
System terminals. 

3X74 

The number 3X74 refers to IBM's 3174 or 3274 control units. 

Terminology and conventions xv 



Special messages 

Look for these special cues throughout the guide. 

+ Note: A note like this presents additional infonnation or interesting 
sidelights. 

6. Important Be sure to read everything that's labeled with the word Important. !::. 

.A Warning Warnings like this indicate potentially serious problems. .& 

xvi Preface: About This Guide 

A special typeface indicates text that you should type: 

It looks like this. 

Related manuals 
For infonnation about how to use your Macintosh computer, refer to the 
following manuals, which came with your Macintosh computer: 

• Macintosh II Owner's Guide: This manual explains how to set up and use 
your Macintosh II. 

• Macintosh Utilities User's Guide: This manual describes how to initialize, 
or fonnat, your hard disk. The Macintosh New Features Update booklet 
explains how to install the system software. 

You might want to refer to the manuals that came with your host network 
equipment. In addition, many books are available that explain various aspects 
of 3270 communication. For example, see the following IBM documentation: 

• IBM 3270 Information Display System Information (GA27-2739-21): 
This book describes various components of IBM's 3270 Information 
Display Systems, including tenninals, personal computers, printers, and 
control units. 



• IBM 3270 Information Display System: 3274 Control Unit Description 
and Programmer's Guide (GA23-0061): This guide provides system-level 
reference material and describes programming characteristics of 3274 
control units and attached terminals. 

Related manuals xvii 





c H A P T E R 

Introducing MacDFT 

MACDFT™ APPLICATION ALLOWS YOUR APPLE® MACINTOSH® II 

computer to emulate an IBM 3270 Information Display System 

terminal. Terminal emulation means that the Macintosh appears to the 

IBM host as a 3270 display terminal, without any apparent operational 

differences between the Macintosh and an actual 3270 terminal. This chapter 

describes the features of MacDFT and tells you what you need to get 

started. 

1 



Upgrading the memory 
for the Coax/Twinax card 

The Apple Coax/Twinax card 

To use MacDFT, you must install the Apple Coax/Twinax card in your 
Macintosh II computer. The card plugs into one of the Nubus slots in the 
Macintosh II and connects to an IBM host via a 3'A7 4 control unit using 
standard RG-62AU coaxial cable. 

The Coax/Twinax card is an intelligent communication card based on the 
Macintosh Coprocessor Platform™. With its own microprocessors, operating 
system, and memory, this card operates independently of the memory and 
processing ability of the Macintosh computer. Because all the 
communication processing is done on the Coax/Twinax card, communication 
between the Macintosh and the host does not affect the speed of 
Macintosh applications. Chapter 2 tells how to install your interface card and 
connect your coaxial cable. 

You can upgrade the memory on your Coax/Twinax card by adding the 
Macintosh Coprocessor Platform card expansion kit. The standard card is 
equipped with 512K (kilobytes) of memory; using the Macintosh II 
Macintosh Coprocessor Platform card expansion kit, you can increase the 
memory on your communication card to 1 MB (megabyte). The Macintosh 
Coprocessor Platform card expansion kit is available through authorized 
Apple dealers, who can install it on the Coax/Twinax card. 

•:• Note: MacDFT 1.0 does not require additional memory on the Apple 
Coax/Twinax card. 

About MacDFT 

MacDFT enables you to have terminal emulation with Macintosh user 
interface enhancements such as pull-down menus and windows. You can 
share data between the Macintosh and the IBM host computer either by 
copying and pasting data from applications, or by transferring files. MacDFT 
functions under MultiFinder™. 

2 Chapter 1: Introducing MacDFf 



Using MacDFf, your Macintosh can emulate an IBM 3270 Information 
Display System terminal and communicate with an IBM host through a 3174 
or 3274 control unit. The control unit links the terminal and the host. The 
control unit and host can be configured in several ways. The configuration of 
the control unit and host determines the type of terminal your Macintosh II 
emulates. Figure 1-1 shows two typical configurations for Macintosh 
connections to a local and remote host. 

• Figure 1-1 The Macintosh connected to a control unit and a host 

Remote configuration 
with MacDFf software 

Host 

Local configuration 
with MacDFf software 

Lill -

I 

Host 

Coaxial cabling 

Channel connection 

Remote connection -Z.. 

~ ' D 

D 

37X5 front-end processor 3X74 control unit Macintosh II 

3X74 control unit Macintosh II 
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A terminal, or computer emulating a terminal, can communicate with an IBM 
host that supports either a single session or multiple sessions. The control 
unit port, the configuration of the host, and the configuration of the 
MacDFT software determine which communication mode your Macintosh 
can use. With MacDFT version 1.0 software, you can connect your Macintosh 
to a 3270 network and emulate a single 3270 terminal session. Future versions 
of MacDFT will support multiple sessions running concurrently. 

What you need to get started 

You can use MacDFT on any of the Macintosh II family of computers, with 
the standard or extended keyboard. 

D. Important Your Macintosh II must have system software version 6.0.3 or a later version. 6 

To use MacDFT, you must have the following: 

• the MacDFT 1.0 disk 

• an Apple Coax/fwinax card 

• a coaxial cable connected to a 3174 or 3274 control unit 

On the IBM host, you need the appropriate file transfer software: 

Software 

MVS/TSO operating environment 

VM/SP host operating environment 

Part number 

5665-311 

5664-281 

Appendix C lists the IBM host and communications equipment with which 
MacDFT works. 
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c H A p T E R 2 

Setting Up MacDFT 

HIS CHAPTER EXPLAINS HOW TO INSTALL THE COAX/TWINAX CARD AND 

Ma.~DFT software. If you have just received your new Macintosh II, you 

must first set it up before you install MacDFT. You should install your 

Coax/Twinax card at the same time that you install your video card. See your 

Macintosh owner's guide for instructions on how to install the video card. If 

your Macintosh personal computer is already set up, you can skip to 

"Installing the Hardware for MacDFT," where card installation is also 

covered. 



What you need to install 
MacDFf 

6 Chapter 2: Setting Up MacDFf 

Before you begin 

If you have just received your Macintosh II equipment and have never used a 
Macintosh before, check your Macintosh II owner's guide for information on 
setting up and using your new computer. You must know some of the basic 
information on how to use the Macintosh computer before installing and 
using MacDFT. 

After setting up your Macintosh, you might want to use the tutorial disk to 
learn about the Macintosh computer. Your owner's manual explains how to 
use the tutorial. Once you feel comfortable using the mouse and the desktop, 
you should initialize your hard disk and install the system software. Follow 
the instructions in the hard disk owner's guide. 

To install MacDFT, you should have an Apple Coax/Twinax card, this manual, 
and a disk labeled MacDFf 1.0, as shown in Figure 2-1. Your Management 
Information System (MIS) department should have provided an installed 
control unit with a coaxial cable attached. 

+ Note: You'll also need a Phillips screwdriver to install your card. 

• Figure 2-1 What you need to install MacDFf 

~ 
Disk 
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Unpacking the card 

Installing the card 

Installing the hardware for MacDFT 

This section tells you how to install your hardware, which means installing 
your card and attaching the coaxial cable. If you have already installed your 
Coax/fwinax card, skip ahead to the section called "Installing MacDff 
Software." 

Keep the card in its protective, antistatic bag until you're ready to install it. 
When you take the card out of the bag, hold it by the edges, not by the 
components. Be sure not to touch the gold pins on the bottom edge of 
the card. 

Follow these steps to install the Coax!f winax card. 

1. Turn off the power. 

Figure 2-2 shows the power switch on the back of the computer. 

A Warning Make sure that the power to all your computer equipment is turned off, but 
leave the power cords plugged into a grounded outlet. This keeps your 
computer system safely grounded. 

Check the power indicator light on the front of the computer to make sure 
the power is off. If the power has been on, wait at least five minutes before 
continuing, to allow the power supply case inside the computer to cool 
down . .A. 

• Figure 2-2 Make sure the power is off 

\\\\\\\\\\\\\\\l\llllllllllllil//1/1 0000000 ~ I 
Power switch ---------+-t:..J 
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2. Remove the computer's lid. 

a. Using a Phillips screwdriver, remove the security screw at the top 
center of the computer's rear panel. 

b. Grasp the rear comers of the case, as shown in Figure 2-3. 

c. Press on the lid latches with your fingers while you lift up the back of 
the lid. 

d. When you feel the lid release, lift it off the case and put it aside. 

• Figure 2-3 Removing the lid 

Security screw-----------~ 

111111111111111111111111111111111111 DODOO 00 

Lid latches--------~---------------/ 

3. When the power supply case has cooled down, touch the metal 
part of it, as shown in Figure 2-4. 

Touching the metal part of the power supply case discharges any static 
electricity that may have built up on your clothes or body. 

.... Warning Remember, the power supply can get very hot in normal use. If the computer 
has been on, wait at least five minutes for the metal case to cool down 
before you touch it. A. 
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• Figure 2-4 Touching the power supply case 

0 

D DD D 

4. Select an expansion slot and find the expansion cover shield 
that's directly behind it. 

The expansion slots are narrow plastic strips, as shown in Figure 2-5. You 
can install the Coax/Twinax card in any slot. 

+ Note: Install the card in a slot where the outside cables are least likely to 
interfere with other cables. 
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• Figure 2-5 The expansion slots and expansion cover shield 

Expansion----------------+­
cover shield 
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5. Remove the expansion cover shield that's behind the expansion 
slot you intend to use. 

Lift up the shield until its free of the guide and pin. Save the shield; it 
protects the interior of your computer, and you will need to reinsert it if 
you take the card out of the slot later. 

•> Note: Attached to the end of the card is a shield that will replace the 
shield you just removed. It fits into the guide the same way that the 
expansion cover shield fits. 

6. Push out the plastic hole cover that lines up with the slot you 
plan to use. 

a. Grasp the cover, with your thumb inside the computer and your 
fingers outside. 

b. Push the cover out with your thumb and set it aside, as shown in 
Figure 2-6. 

• Figure 2-6 Removing the hole cover 

Installing the hardware for MacDFT 11 



7. Insert the Coax/Twinax card into the expansion slot. 

a. Pick up the card by the edges or the top comers. (Avoid touching the 
pins on the bottom of the card.) 

b. The expansion cover shield on the back of the card attaches to the 
inside of the back panel in the same way as the shield you removed in 
step 5. Align the card so that the guide is through the lower slot in the 
shield, and the pin sticks up slightly through the hole at the top of the 
shield, as shown in Figure 2-7. 

c. Align the connector on the bottom of the card directly over the slot. 

d. Place one hand on the top of the card, directly over the connector area, 
and then push down firmly until the connector is fully seated. To see 
if the card is properly connected, lift it gently. If it resists and stays in 
place, it's connected. 

,6,. Important Don't force the card into place. If you meet a lot of resistance, pull the card 
out and try again. Don't wiggle the card from side to side when you insert it. 
Wiggling the card puts unnecessary stress on the card and slot. t::. 

• Figure 2-7 Aligning the card 
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8. Replace the computer's lid. 

a. Tip the front of the lid down so that the three square fasteners on 
the lid catch the three hooks inside the front of the computer's case. 
(See Figure 2-8.) 

b. Lower the back of the lid onto the case and press down until the rear 
latches snap into place. 

c. Press on the front of the lid to ensure that the square brackets are 
fully seated on their hooks. 

d. Reinsert and tighten the security screw. 

You are now ready to connect the Macintosh to your host. 

• Figure 2-8 Replacing the lid 
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Connecting the coaxial 
cable 

The Coax/Twinax card has a coaxial connector to which you connect the 
coaxial cable. The other end of this cable should be connected to your installed 
control unit. Figure 2-9 illustrates how to connect the coaxial cable to your 
Macintosh . 

.._ Warning It is important to use coaxial cables built to the RG-62AU standard, to avoid 
radio and television interference. • 

• Figure 2-9 Connecting the coaxial cable to the Macintosh 
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Installing MacDFT software 

Insert the MacDFT disk into your disk drive. Double-dick the disk to open it. 
You should see the following icons, which are shown in Figure 2-10: 

• the MacDFT application 

• the MacDFT Config file 

• the Apple Real-time Operating System Environment (A/ROSE™) Prep file 

• Figure 2-10 Icons on the MacDFf disk 

MacDFT M.:icDFT Config 

~ 
~ 

A /ROSE Pri?p 

Drag the MacDFT application to your hard disk. Drag the MacDFT Config 
file and the Apple Real-time Operating System Environment (A/ROSE) 
Prep file to your Macintosh System Folder. The MacDFT Config file contains 
the driver and configuration information for MacDFT. The A/ROSE Prep file 
contains software that communicates between the communication card and 
the Macintosh II. 

After you put these files in place on your hard disk, restart your Macintosh 
computer. When you open the Control Panel, you will see the MacDFT Config 
icon displayed. Figure 2-11 shows the Control Panel with the MacDFT Config 
icon installed. 

6 Important If you have not installed the Coax/fwinax card, the MacDFT Config icon will 
not appear on the Control Panel. See "Installing the Hardware for MacDFT," 
earlier in this chapter, for installation instructions for the card. !:::,, 
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• Figure 2-11 The Control Panel with the MacDFT Config icon 
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After you select the MacDFT Config icon from the Control Panel, the 
MacDFT Control Panel will appear. It shows the slot in which your 
Coax/Twinax card is installed, and the CUT button. Figure 2-12 shows the 
MacDFT Control Panel. The Control Panel displays CUT as the selected 
option. CUT is an acronym for Control Unit Terminal, a tenninal 
emulation mode that supports one session. The other options, DFT (SNA) 
and DFT (NON-SNA), are dimmed because these options are not available in 
MacDFT application version 1.0. 

Click the Update button at the bottom of the Control Panel. Clicking this 
button tells MacDFT in which slot your Coax/Twinax card is installed, and 
creates a MacDFT Prefs file in your System folder. After clicking the Update 
button, you see a message telling you that the configuration is updated. 

When you see the MacDFT icon on your hard disk and the MacDFT Config 
icon in your Contol Panel, you have installed your software. 



• Figure 2-12 MacDff Control Panel 

D Control Panel 

Gener.al 

10f~I !lllll 
MacDFT Config .l!i[: 

t'lacDFT™ Configuration 

~·--1 
Oi@2050tO'.:>Qt; 

@CUT 

0DH1SNH) 

Coax 

Q DH 1 NGN -\NfP 

n Update JJ 

Installing MacDff software 17 





c H A p T E R 3 

Configuring MacDFT 

BEFORE USING MAcDFf ON voua MACINTOSH II coMPITTER m EMULATE AN 

IBM 3270 Information Display System terminal, you must configure your 

MacDFf software. Host equipment is configured according to the available 

equipment and needs of the users. You must configure MacDFf to 

communicate with each host configuration. So that your MacDFf software 

can emulate certain features of the IBM terminals, you can use a 

configuration document to store your configuration choices. Using a 

MacDFf configuration document, you can launch your MacDFT application 

without having to enter configuration information each time. 

This chapter tells you how to customize your sessions and save your choices 

in configuration documents. You can then use your customized MacDFf 

configuration document to start a MacDFf session that contains your 

choices for terminal type, display options, file transfer, and other terminal 

emulation options. 
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• Figure 3-1 MacDFT Configure 
menu 

Terminal ... 
Display .•• 
Keyboard ... 
Lock ... 
File Transfer • 
Country • 
From Control Panel 

Choosing terminal settings 

Customizing a configuration document 

When you first double-click the MacDFT application, you use a default 
configuration that causes the Macintosh to emulate a model 2 terminal. You 
can customize your application by choosing commands from the Configure 
menu, as shown in Figure 3-1. Each menu command gives you options for 
customizing your MacDFT document. 

The next few pages explain how to use all the commands in the Configure 
menu except the Keyboard command, which is covered in Chapter 5, and the 
File Transfer commands, which are discussed in Chapter 6. Switch Settings for 
display options are also described in this chapter. The Switch Settings 
command is in the Command menu. 

The Terminal Settings dialog box lets you make choices about the terminal 
that your Macintosh II emulates while using the MacDFT application. 
Figure 3-2 shows the dialog box that appears when you choose the Terminal 
command from the Configure menu. 

• Figure 3-2 Terminal Settings dialog box 

Terminal Settings 

Window name I 
Emulation Model !Display Model 2 (24H80) 

181 Open at MacDFT launch 

Cancel ) ( OK B 

20 Chapter 3: Configuring MacDFT 



This dialog box lets you configure your terminal emulation session by making 
these choices: 

• Window name You can rename your session window. Rename your 
session window by typing over MacDFT 1.0 with the session name you 
have chosen. Having names for sessions is helpful if you log on to several 
hosts. You can rename the window name in each configuration file that 
you use. 

• Emulation model Figure 3-3 shows the menu from the Terminal 
Settings dialog box that lets you choose the display model you want 
MacDFT to emulate. The numbers refer to the number of rows and 
columns each emulated terminal provides. 

• Open at MacDFr Jaunch This check box tells MacDFT to open an 
emulation window when you launch MacDFT, thereby starting the 
session with the host. If you deselect this option, you can open a 
window after launching MacDFT by choosing the Start Emulation 
command from the Command menu . 

.._ Warning Make your terminal settings choices before logging on to the host; if you 
don't, you must reset the terminal to put your choices into effect. The 
MacDFT application will display the alert box shown in Figure 3-4. If you 
click Yes, your connection with the host is reset and you may have to log on 
again to the host. If you do not want to reset the session, click No. .A 

• Figure 3-3 Emulation Model pop-up menu 

Emulation Model ./01splay Model 2 124!!80 I 
Display Model 3 (32H80) 
Display Model 4 (43H80) 
Display Model 5 (27HI 32) 
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Choosing display settings 

• Figure 3-4 "Tenninal settings" alert box 

To install the changes, the 
terminal must be reset. Do 
you wish to proceed? 

No ( Yes J 

When you choose the Display command, a dialog box appears that lets you 
choose display options. You can use each of the display options with default 
settings for your terminal emulation session, or select choices that you store 
in your configuration document. During a MacDFf session, you can change 
the display options, except for Numeric lock, without resetting the terminal. 

Figure 3-5 shows the default options you see when you choose the Display 
command. Each of these options is described after the figure. 

• Figure 3-5 Display Settings dialog box 
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• Figure 3-6 "Font size" menu 

7 point 
9 

14 
18 
24 

Choosing numeric lock 

If you select this option, you can use only numbers (0 through 9), the DUP 
key, the period(.), and the minus sign(-) when you are typing data into a 
field that is defined by the host application as numeric. 

Choosing font size 

You can choose the font size either by choosing the "Font size" pop-up 
menu or by choosing the "Resize font" option. The "Font size" menu, as 
shown in Figure 3-6, lets you select a font size. The "Resize font" option lets 
you choose whether to automatically change the font to fit the terminal 
model that the MacDFT software is emulating. 

• Font size The "Font size" option lets you change the font size through 
the font menu. If you click this box, you see a pop-up menu that shows 
your font size choices. The default font size is 12 points. To change the 
font size, choose either 7, 9, 14, 18, or 24 points. 

• Resize font The "Resize font" option allows you to choose whether to 
change the font size automatically when you change terminal types. The 
default font size is the largest font for a given terminal model that fits in 
a fully expanded window. The default MacDFT window size is 24 rows 
by 80 columns. If you want to change window dimensions, use the size 
box at the lower-right comer of your window to resize the window. 

Table 3-1 shows the terminal types and the default font size. 

• Table 3-1 Terminal models and default font sizes 

Terminal model 

Model 2 

Model 3 

Model 4 

Model 5 

Font size 

12 points 

9 points 

7 points 

7 points 

Rows and columns 

24x80 

32x80 

43x80 

27x132 
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You can make two choices for resizing the font: 

• "Resize font" unselected If you use this default setting, the window 
changes to accommodate the rows and columns; the font size remains 
the same size you have chosen from the "Font size" menu. If you choose 
this option, you can see all your columns and rows. In some cases, the 
window may not be able to display all the rows and columns, and you 
must use the scroll bars to display additional data. 

• "Resize font" selected If you select this option, MacDFT changes the 
font size to fit the terminal model you have selected, as shown in 
Table 3-1. This choice lets you display the full column width associated 
with each model type, except for model 5, where you must use the 
horizontal scroll bars to see all 132 columns. The window size also changes 
to accommodate the extra rows and columns; the font size remains the 
same. 

Choosing colors 

Choices for colors depend on whether you are using a color monitor and 
whether the attached control unit supports color. Figure 3-7 shows the 
portion of the Display Settings dialog box that lets you choose colors. 

• Figure 3-7 Color options 
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• Figure 3-8 "Select colors" menu 

Select colors: Blue ... 
Red .. . 
Pink .. . 
Green .. . 
Turquoise ... 
Yellow .. . 
White .. . 
Background .. . 
Status line .. . 

• Color support The menu shows three buttons labeled "Monochrome," 
"Base color," and "Extended color." ("Base color" and "Extended color" are 
dimmed if you use a monochrome monitor or if you have the Control 
Panel for the monitor set to monochrome.) You have these choices for 
color if you have a color monitor: 

o Monochrome If you click this button, the monitor displays black 
and white. 

o Base color If you click this button, the monitor can display four 
colors: white, red, blue, and green. 

o Extended color If you click this button, the monitor can display 
seven colors: white, red, blue, green, pink, yellow, and turquoise. 

• Background You can choose your background color by clicking either 
White or Dark. The default background for MacDFf is the dark 
background, which is the default background for IBM terminals. 

•!• Note: If you choose to have a white background, MacDFf will display 
white data from the host in black. 

• Select colors If you have chosen base or extended colors, you can 
choose the colors for your background and for the status line. Figure 3-8 
shows the pop-up menu that lets you choose colors. 

You can pick the exact shade of blue, red, and other colors that you want to 
use for the named IBM color, for the window background, and for the status 
line. Figure 3-9 shows the color wheel that you use for selecting your colors. 

To alter the color of the background or status line, select the item that you 
want to modify. For example, say you wanted to change the color of the 
status line to pink. You would choose the "Status line" command from the 
"Select colors" menu. Use the cursor on the color wheel and the scroll bars to 
modify the color. The scroll bar controls the brightness of the color; the 
cursor on the color wheel changes the hue. When you have selected the exact 
shade of pink that you want for the status line, click OK. 
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Multiple configuration 
documents 

• Figure 3-9 "Color wheel" dialog box 
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Saving screens 

1.3 

The Display Settings dialog box lets you name the file in which to save a 
screen image that you see during a MacDFf session. Saving screens is 
explained in Chapter 4. 

Saving configuration settings 

You can change configuration settings either before or during a session. After 
you have completed a session, if you have made changes to the 
configuration, MacDFf queries whether you want to save these changes in 
your configuration document. If you click Yes, MacDFf asks you to name 
the configuration document: you can save the changes either to the 
document with which you launched the session, or to a new document. If 
you click No, any changes made to the configuration document are not 
saved. 

You can create several configuration files. If you use more than one host or 
application, you can create a configuration file for each. Having several 
configuration documents is particularly helpful if you need different display 
or terminal settings for each host or host application. 
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Locking MacDFI' 

For example, say you saved your configuration settings from a session while 
you were logged on to a host running VM/CMS. If you launch this document 
and you log on to a host running MVS/TSO, you can modify your settings, 
and save these modifications, using the Save As command. 

The MacDFf application allows you to use a password as a security lock 
mechanism. This security lock mechanism is similar to the lock and key on a 
3278 terminal, but locking is done by the application software rather than a 
physical lock and key. The lock prevents users who do not know your 
password from using MacDFf on your Macintosh, but it does not prevent 
them from using the Macintosh. 

Setting a password 

To lock your MacDFf application, choose the Lock command from the 
Configure menu and type a password when MacDFf prompts you, as shown 
in Figure 3-10. When you type a password, the letters you type are masked 
out on the screen by asterisks(*). Your password can be up to 16 characters 
long. 

When you are typing your password, you see the dialog box shown in 
Figure 3-10. After you enter or delete your password, you see the dialog box in 
Figure 3-11, prompting you to confirm your password. 

• Figure 3-10 "New password" 
dialog box 

Enter new password: 

Cancel t OK D 

• Figure 3-11 "Password 
confirmation" dialog box 

Please enter password 

again to confirm: 

Cancel I OK 3 
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The dialog box in Figure 3-12 appears when you launch MacDFT after using 
the Lock command. After you have chosen your password, MacDFT asks you 
for this password each time you launch. After you type your password, the 
MacDFT software lets you launch your application. 

• Figure 3-12 "MacDFT locked" alert box 

Macon is locked. 

Please enter password: 

Quit K OK ) 

Changing or deleting a password 

You can change or delete your password after you have entered the correct 
password. First, choose the Lock command from the Configure menu. 

• To change your password, type a new password in the text box. A dialog 
box appears that asks you to type your new password again. Type your 
new password exactly as you typed it the first time. 

• To delete your password, type no characters; just click OK. When you are 
asked to confirm your password, click OK again. After you delete the 
password and click OK, MacDFT is unlocked. 

Lost password 

If you have lost or forgotten your password, you or your system 
administrator can launch an unlocked copy of MacDFT. Copy the unlocked 
copy to your hard disk, launch the application, and choose a new password. 
Be sure to discard the locked copy. 
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Country customization 

Configuring from the 
Control Panel 

Choosing switch settings 

MacDFT can be localized for use in different countries. Supported countries 
will appear when you click the Country menu option. 

This command allows you to reconfigure MacDFT from one Coax/Twinax 
card to another card. When you choose this command, your session will be 
reset, and the current values configured in the Control Panel will be used to 
start the new session. 

You can change Switch settings by choosing the Display Switches command 
in the Command menu. Switch settings are displayed in a dialog box as check 
boxes and buttons, as shown in Figure 3-13. 

• Figure 3-13 "Switch settings" dialog box 

Switch Settings for MacDFT 1 o 

H<lH' tnhr S\H1ih 

@ Hwr ( OiM [''-"'···; 

Cursor Type 

@ Underline cursor 0 Block cursor 

D Cursor blink D Show cursor position 

Click on keystrokes if ... 

0 Input inhibited O Normal @Neuer 

Cancel OK 

Saving configuration settings 29 



If you make a change to the "Switch settings" dialog box, you can save the 
change as part of your configuration document. See the section titled "Saving 
Configuration Documents," earlier in this chapter. 

Figure 3-13 shows the default settings for the options in the "Switch 
settings" dialog box. To change a setting, click a check box or button. An X in 
a check box or a dark circle in a button indicates that the option is chosen; an 
empty check box or button means that the option is not chosen. 

• Base Color Switch You can choose either four color or two color for 
your base color selection. 

o If you select "Two color," base color is not used and the session 
operates using two colors, emulating a monochrome display. 

o If you select "Four color," the terminal runs in normal base color 
mode, except when extended color attributes are specified by the 
host; in this case, the switch setting is ignored. 

The base color switch is dimmed if monochrome has been selected in the 
Display Settings dialog box, if you have a monochrome monitor, or if you 
have color monitor that is configured for monochrome in the Control Panel. 

• Cursor Type The cursor can indicate its position by underlining the 
character or by forming a block around the character. The default is 
underline; if you select "Block cursor," the host displays a rectangle 
surrounding the character on which the cursor lies. 

• Show cursor position If you choose "Show cursor position," the 
current cursor position is displayed on the status line at the right side. 
The cursor position is indicated by two numbers separated by a slash (/); 
for example, 06/07 means that the cursor is on the sixth row and seventh 
column. 

• Cursor blink You can choose whether you want your cursor to blink. 

• Click on keystrokes if You can choose when you want your 
keystrokes to click. If you choose this option, MacDFT simulates the 
click of the emulated terminal. 
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c H A p T E R 4 

Communicating With a Host 

HE MACDFT PROGRAM ALLOWS YOU TO USE YOUR MACINTOSH II COMPUTER 

to communicate with an IBM host. This chapter describes the procedures 

for launching MacDFT, copying and pasting data between applications that 

you run on the host and on the Macintosh computer, and terminating the 

session. It also addresses printing, using Autokey features, and using the 

Command menu. 
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launching from the icon 

launching a configuration 
document 

When you use MacDFf on your Macintosh computer connected to a host via 
a control unit, your computer has these capabilities: 

• You can use the MacDFf program to read and edit files or execute 
programs on your IBM host. 

• You can copy and paste text between applications running on the 
Macintosh and the IBM host. 

• You can transfer whole documents between the Macintosh and IBM 
host by using the File Transfer command. File transfer is described in 
Chapter6. 

Launching MacDFT 

To begin a terminal-emulation session, you can either double-click the 
MacDFf application icon or double-click a MacDFf configuration document. 

If you double-click the MacDFf application icon, MacDFf launches the 
default configuration settings that causes the Macintosh to emulate a 
model 2 terminal. 

You can also launch MacDFf by simultaneously pressing the Command key 
and double-clicking the application icon. This causes the New and Open 
commands to be enabled in the File menu, letting you open a customized 
configuration document or a new configuration document. 

If you double-click a configuration document that you have customized as 
described in Chapter 3, MacDFf software emulates the terminal type and 
display choices you have configured. 
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Starting an emulation 
session 

Changing display options 

After launching MacDFT, you see the host's initial Jog-on screen. Typically, 
you must have an account and password to Jog on to a host. 

+ Note: If you are unsure about your host account or password, see your 
system administrator for this information. Follow the procedures at your 
site to log on to the host. 

After Jogging on to the host, you can do all the things that you normally 
would do while logged on to a host, such as browsing and editing files, using 
host applications, and executing programs. You can also change your 
display options, and copy and paste text between applications that are 
running on the host and on the Macintosh. 

+ Note: If you do not see on-line symbols in the status line, your coaxial 
cable may not be connected. Check the coaxial cable attached to your 
Macintosh II. If the coaxial cable is correctly attached and you do not see 
on-line symbols, call your system administrator to determine the 
problem. 

To change your display options during a terminal emulation session, choose 
the Display command from the Configure menu. Choose from the options 
listed in the Display Settings dialog box. For information on how to configure 
these options, see Chapter 3. 

Copying and pasting host data 
MacDFT allows you to use the standard Macintosh copy and paste functions 
to transfer information between documents. MacDFT supports copying and 
pasting text between applications on the Macintosh computer, such as 
MacWrite®, and text editing applications on the host, such as XEDIT. If you 
are not familiar with copying and pasting text between documents, see your 
Macintosh II owner's guide. 
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Copying text You can copy text between applications that run on the host and your 
Macintosh computer. 

Copying text from the Macintosh to the host 

To copy data from the Macintosh and paste it to the IBM host application, 
follow these steps: 

1. In the application window, select the text you want to copy. Then 
choose the Copy command from the Edit menu. 

2. Click the MacDFf session window. 

3. Select the host application into which you want to copy text. 

4. Place your cursor where you want the text to appear, and choose the 
Paste command from the Edit menu. 

+ Note: Some applications on the host have protected fields, that is, fields 
in which you are not allowed to type. If you paste text into an application 
that has protected fields, pasting stops when you get to a protected 
field. Pasting data that you have copied from a host application may have 
an extra character space in every field. 

Copying text from the host to the Macintosh 

To copy data from the host and and paste it to the Macintosh, follow these 
steps: 

1. Select the text that you want to copy from the host application. Then 
choose the Copy command from the Edit menu. 

2 Select the Macintosh application into which you want to copy text. 

3. Place your cursor where you want the text to appear, and choose the 
Paste command from the Edit menu. 

+ Note: Pasting data copied from a host application may have an extra 
character space in every field. 
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Copying tables 

• Figure 4-1 File menu with Close, 
Close All, and Quit commands 
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The Copy Table command in the Edit menu lets you copy tabular information 
from the host to an application on the Macintosh. This command is useful 
for copying information into spreadsheets or databases on the Macintosh 
computer. The Copy Table command translates a string of two or more 
spaces into a tab character. 

To copy tabular information, follow these steps: 

1. Open the host application and select the information you want to copy. 

2 Copy the information by choosing the Copy Table command. 

3. Choose the Paste command from the Edit menu, and paste the text you 
copied into a Macintosh file or application. 

•> Note: You can use the Command key while selecting text to modify the 
selection rectangle. If you hold down the Command key while selecting 
text, you can copy sections of text that do not extend to the window 
margin. 

Terminating the session 

The File menu provides commands for terminating a MacDFT session. 
Figure 4-1 shows the File menu with the Close, Close All, and Quit commands 
for terminating a session. Typically, you must log off the host before 
terminating the session. If you are unsure about your site's procedures, see 
your system administrator. 
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Close 

Close All 

Quit 

The Close command closes the session on the host, but keeps the 
configuration document that you launched open. After using the Close 
command, you can start a new session by choosing the Start Emulation 
command from the Command menu. 

The Close All command closes the session and configuration document, but 
keeps you in the MacDFT application. You can start another emulation 
session by choosing the New or Open command from the File menu, and 
then choosing the Start Emulation command from the Command menu. 

When you choose the Close All command, MacDFT queries whether you 
want to save your configuration document. If you have changed your 
settings; click Yes if you want to save your changes; click No if you do not 
want to save your changes. To start a new emulation session, you must 
reconnect. 

The Quit command terminates your session and closes the MacDFT 
application. If you have made changes to the configuration, MacDFT queries 
whether you want to save these changes in your configuration document. If 
you click Yes, MacDFT asks you to name the configuration document; you 
can either save the changes to the document with which you launched the 
session, or to a new document. If you click No, any changes you have made 
to the configuration document are not saved. 

Printing with MacDFT 

You can print documents and files produced during your MacDFT session. 
You can use either an Apple printer that is connected to your Macintosh, or an 
IBM printer that is connected to the control unit to which your Macintosh is 
connected . 

.6. Important You cannot use your Apple printer for host-initiated printing. t::,,, 
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Printing documents on an 
Apple printer 

Printing documents on an 
IBM printer 

Printing or saving a screen 
image 

If your Macintosh II is connected to an Apple printer, you can print 
Macintosh-resident documents during a MacDFT session. You can use any 
type of printer supported by Apple. You can print documents that you have 
created during a MacDFT session, or documents that you have downloaded 
from the host. 

You can print host-resident documents during a MacDFT session to an IBM 
printer that is connected to your control unit or host. Use the print 
commands that are supported in your IBM environment. Figure 4-2 shows 
one possible configuration of MacDFT with a system printer attached to the 
control unit. 

• Figure 4-2 MacDFT configuration with an IBM printer 

~ 
4214 printer 

Host 3X74 control unit Macintosh II 

The File menu, as shown in Figure 4-3, has two commands for creating screen 
images: Print Screen and Save Screen on disk. 

•:• Note: Local copy, as it is understood by the IBM community, means 
sending a snapshot of your screen to the control unit, which prints it on a 
3287 printer. MacDFT version 1.0 does not support host or terminal local 
copy. However, you can create a screen image that you can save to disk or 
print from the Macintosh II computer during a MacDFT session. 
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• Figure 4-3 File menu 
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Print Screen 

To print a terminal screen that you see during a MacDFf session, choose the 
Print Screen command. The terminal screen image is printed to an Apple 
printer that is available to your Macintosh II. 

Save Screen on Disk 

MacDFf lets you save a screen image that you see during a MacDFf session. 
The Save Screen on Disk command is dimmed until you have chosen the 
Display command and selected either the New File or Select File button in the 
Display Settings dialog box. The screen image is saved as a text file. Figure 4-4 
shows you the portion of the Display Settings dialog box that lets you name 
the screen image. 

• Figure 4-4 "'Save screen' file" option 

"Saue screen" file: 

New File Select File 

The Display Settings dialog box lets you choose one of the three buttons: 

• New file Select this option to create a new filename on your disk. 
MacDFf will then prompt you for a new filename. 

• Select file After you choose this option, you see the alert box in 
Figure 4-5. This option lets you choose whether to append to or replace 
the contents of a file on your disk with a new screen image. 
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• Figure 4-5 "Append or replace" alert box 

Lt Append to or replace "fred" 1 

([ Append JJ 

[ Replace J Cancel 

• Drop file Select this option to remove the filename and its path from 
the Display Settings dialog box. 

Click OK at the lower-right comer of the Display Settings dialog box. MacDFf 
places the file in the window that is currently open, showing the pathname. 
The pathname shows the folder in which it resides on your disk. For example, 
Figure 4-6 shows a file that has been named. 

• Figure 4-6 "'Save screen' file" option with a filename 

"Saue screen" file: 
hom9:fr9d 

New File Select File 

After you have clicked either "New file" or "Select file," name your file by 
typing the name under " 'Save screen' file." When you have the image on 
screen that you want to save, go to the File menu and choose the Save Screen 
on Disk command; this causes the screen image to be saved to your disk. In 
the example shown in Figure 4-6, the file "fred" will be saved to the disk 
"home." 

Before using the contents of a screen you have saved to disk, you must first 
open the file using a text processing application, such as MacWrite or 
Microsoft Word. 
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• Figure 4-7 Autokey menu 
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Using the Autokey menu 

The Autokey feature lets you store strings of keystrokes that you use 
frequently in an emulation session. When you choose an Autokey item, the 
keystrokes stored in the Autokey item are played back as if you had just 
entered them with the keyboard. The Autokey menu is shown in Figure 4-7. 

To create an Autokey sequence, go to the Autokey menu and choose New. 
You see a text box labeled "Autokey: Untitled," with a sequence number. 
Figure 4-8 shows "Autokey: Untitled -1." 

• Figure 4-8 Autokey Untitled window 

=o Autokey: Untitled - 1 ~r 
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~ 
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Type the string you want in the Autokey box. If you make a mistake, use the 
Cut or dear command from the Edit menu. If you use the Delete key, it 
becomes part of the string. Figure 4-9 shows an Autokey window with text 
entered. 
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• Figure 4-9 Autokey window with string of text 
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Use the Save As command to give your Autokey a meaningful name. 
Figure 4-10 shows the dialog box you see when you choose the Save As 
command after entering text in an Autokey window. In this example, the 
log-on Autokey is named "logon fred." The maximum size for the Autokey 
name is 22 characters. 

• Figure 4-10 Naming your Autokey 
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Edit 

Delete 
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In the example in Figure 4-10, the "Include in Autokey Menu" box was 
selected, and the "Keyboard Equivalent" text box appears. You can assign a 
keyboard equivalent to your Autokeys. Be careful not to select one of the 
standard Macintosh keyboard equivalents, or one that is already assigned. If 
you select a duplicate, an alert box will tell you that you must rename the key. 
See your Macintosh owner's guide for a list of assigned keys. 

If you click "Include in Autokey menu," Autokeys that you have created and 
saved in a configuration document are listed and can be played from the 
Autokey menu. Autokeys can also be assigned to and played from the 
Keypad dialog box, described in Chapter 5. 

If you do not use the Save As command from the File menu after entering an 
Autokey string, you are prompted by the alert box shown in Figure 4-11. 

• Figure 4-11 "Save changes" alert box 

~ Saue changes to "Rutokey: 
U Untitled - 1" ? 

[ Yes ) 

No Cancel 

If you click Yes, you see the dialog box shown in Figure 4-10. 

The Autokey feature provides commands to edit, delete, play, pause, and 
resume Autokey sequences that you have created. 

The Edit command brings up a scrollable list of Autokey strings that exist in 
your current configuration document, and two buttons, Edit and Cancel. If 
you click a name from the list and choose the Edit command, you can edit the 
string and save it. 

The Delete command lets you delete an Autokey entry. Select the Autokey 
item that you want to remove from the dialog box, and choose the Delete 
command. 
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Play 

Pause 

Cancel Autokey 

Start Emulation 

The Play command executes the Autokey sequence. For example, if you 
created an Autokey named "logon fred," you can choose the Play command 
and choose "logon fred." You can also add it to the Keypad, or play it by 
pressing its keyboard-equivalent keys. The host receives the message exactly 
as it was entered. You will see the letter Pon the status line while you are 
playing the Autokey sequence. 

The Pause command tells the Macintosh to halt execution of an Autokey 
command until you choose the Resume command from the Autokey menu. 
When you select Pause, the letters PP appear on the status line, indicating 
that you have clicked Pause, and the Resume command appears in the 
Autokey menu. The letters PP disappear after you choose the Resume 
command. 

The Cancel command tells the Macintosh to cancel the Autokey sequence. 

Using the Comm.and menu 

The Command menu provides three functions for terminal emulation 
sessions. Figure 4-12 shows the Command menu. 

• Figure 4-12 Command menu 

Display Switches ... 

Reset Terminal 

The Start Emulation command allows you to begin an emulation session 
after choosing the Close command from the File menu. 

Using the Command menu 43 



Display Switches 

Reset Terminal 

The Display Switches command lets you change display options using a 
dialog box. See the section in Chapter 3 titled "Choosing Switch Settings." 

The Reset terminal command lets you end your terminal emulation session 
and begin a new session immediately. Figure 4-13 shows the alert box that 
you see if you choose the Reset Terminal command. 

If you click Yes, your connection with the host is ended and you are 
reconnected to the host. You may have to log on again. If you do not want 
to reset the session, click No. 

• Figure 4-13 "Reset tenninal" alert box 

Are you sure that you want to 
reset the terminal? 

No U Yes m 
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c H A P T E R 5 

Using the Keyboard and Keypad 

MACINTOSH KEYBOARD IS CONFIGURED TO FUNCTION AS AN IBM 3270 

terminal keyboard. Since the Macintosh keyboard has features that differ 

from IBM keyboards, the MacDFT application provides two features that 

enable you to work efficiently with these differences. Using the Option and 

Command keys, you can use the Macintosh keyboard with the functionality 

of the IBM keyboard; and you can send IBM keystrokes from the Keypad 

menu. This chapter explains how to use and customize both of these 

features. 
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• Figure 5-1 Configure menu 

Terminal .. . 
Display .. . 
Keyboard ... 
Lock ... 
File Transfer • 
Country • 
From Control Panel 

Mapping key functions 

Macintosh and IBM 3270 keyboards 

Because the IBM keyboard has some keys that are not standard on the 
Macintosh keyboard, MacDFT has a keyboard mapping feature. The keyboard 
mapping feature allows you to map key functions found on the 3270 tenninal 
to the Macintosh standard or extended keyboard. These key functions are 
discussed in the section titled "3270 Keys." 

To display the Macintosh keyboard and IBM keyboard on your screen, pull 
down the Configure menu, and choose the Keyboard command. Figure 5-1 
shows the Configure menu. 

Figure 5-2 shows the dialog box that appears when you choose the Keyboard 
command. The keyboard window displays two keyboards: an IBM 3270 
keyboard and either the standard or extended Macintosh keyboard, depending 
on which keyboard is connected to your Macintosh. Figure 5-2 shows the 
Macintosh extended keyboard. 

The 3270 keyboard is in the upper half of the window, and the Macintosh 
keyboard is in the lower half of the window. Keys that are dimmed cannot be 
mapped. You can reassign all 3270 keys to the Macintosh keyboard, except for 
the Lock, Shift, and Alt keys. You cannot reassign a 3270 key function to a 
dimmed key on the Macintosh keyboard. 

Keyboard mapping tools 

MacDFT provides buttons to help you map 3270 keys to the Macintosh 
keyboard. The 3270 keyboard has three buttons that represent modifier keys: 

• Unshifted 

• Shift 

• Alt 

46 Chapter 5: Using the Keyboard and Keypad 



• Figure 5-2 Macintosh and 3270 keyboards 
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The Macintosh keyboard has four buttons: 

• Unshifted 

• Shift 

• Option 

• Control 

Clicking any of these. buttons reveals the current key assignment associated 
with these modifier keys. The Shift button, for example, causes all the 
alphabetical keys to be displayed as uppercase letters. Try selecting each 
button to see how your screen display changes. On the Macintosh keyboard, 
you can use the buttons on the screen or the key on your keyboard to change 
your display. 
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3270 keys 

You can map keys from the IBM keyboard that are combined with the Shift 
or Alt key to the Macintosh keyboard in either Unshifted, Shifted, Option, or 
Control mode. The keys that you can reassign are 3270 function keys: Enter, 
Program Function keys 1-24, PAl, PA2, Clear, Attn, Sys Req, Reset, the arrow 
keys, New Line, Home, Tab, Backtab, Insert, Delete, Erase EOF, Erase Input, 
DUP, and Field Mark. If you are already familiar with 3270 keys, you can skip 
ahead to "Mapping 3270 Function Keys to the Macintosh Keyboard." 

The 3270 keys are divided into four major groups according to function. The 
sections that follow provide an overview of 3270 keys. If you need 
instructions for using a key's function, refer to the host application's 
documentation. 

Program Function keys 

There are 24 Program Function (PF) keys, labeled PFl through PF24 on your 
keyboard. The host application you are using assigns its own functions to 
these keys; refer to the application's manual for specific functions. 

Program Attention keys 

MacDFT supports two Program Attention keys, PAl and PA2. The 
application program you are using determines the function of these keys. 

3270 function keys 

The 3270 function keys give commands that are standard throughout 3270 
communication. Table 5-1 gives a complete name for each function and 
briefly describes each function. 

Cursor movement keys 

The cursor movement keys move the cursor on the screen. This function is 
local; no host processing is involved. 

48 Chapter 5: Using the Keyboard and Keypad 



• Table 5-1 3270 function keys 

dear 

DUP 

Enter 

Erase to End of Field (EOF) 

Erase Input 

Field Mark 

Home 

Newline 

System Request 

Attention 

Arrow keys 

Function 

Clears the screen during a session. 

Allows you to duplicate the information in one 
field into another field. 

Sends a request for attention. 

Erases data from the cursor location to the end 
of the input field. 

Erases data in all input fields. 

Puts the Field Mark character into the current 
input field. The application program determines 
its function. 

Returns the cursor to the first nonprotected 
field. 

Moves the cursor to the next line, or to line one 
if there are no input fields. 

Either sends a signal to the host system to tell 
the program you have a test request message, 
or clears the display screen and switches the 
display station between the application and the 
control program. 

Requests the attention of the host. 

Moves the cursor in the direction of the arrow. 

Table 5-2 shows key reassignment for special characters that do not exist in 
ASCII, but are used in EBCDIC. 
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Mapping 3270 function 
keys to the Macintosh 
keyboard 

• Table 5-2 Key reassignment for nonsupported Macintosh special characters 

EBCEDIC character Macintosh key (ASCH character) 

The cent sign(¢) 

Logical NOT sign ( ,) A 

Broken vertical bar (:) 

When you map a 3270 function key to a key on the Macintosh keyboard, 
pressing that Macintosh key causes it to have the 3270 function. For example, 
you could map the 3270 delete symbol to the Macintosh keyboard with the 
Option button selected. When you press the Macintosh Option key and the 
key that you have mapped, you send a delete keystroke. This section explains 
how to change the function of a key and how to delete a function from the 
keyboard. 

Changing the function of a key 

Here are two ways to assign the function of an IBM key to a Macintosh key: 

• Drag the key from the IBM keyboard, and position it on the Macintosh 
key on which you want to assign it. Release the mouse button. 

• Click the key on the IBM keyboard that you want to move to the 
Macintosh keyboard. Click the key on the Macintosh keyboard that you 
want to have the function of the IBM key. 

Figure 5-3 shows IBM keys assigned to the Macintosh keyboard. 
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Program Function (PF) keys 

IBM delete key mapped to the Macintosh 
keyboard 

Program Attention (PA) keys 

Saving your customized 
keyboard 

• Figure 5-3 Keys with new functions 
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Deleting the function of a key 

To delete the function of a key that is mapped with a 3270 function, click it 
and drag that key to the trash can, and release the mouse. The key where the 
3270 function had been becomes blank. 

After you have deleted the 3270 function from a key, you can map another 
3270 function key to the blank key, you can replace the key's original 
function, or you can leave it blank. 

When you have made all your key mapping selections, click the OK button to 
save your choices for this session. If you have made choices that you do not 
want to save, click the Cancel button. This causes the keyboard to revert to 
the last-saved keyboard settings. You can save your choices into a 
configuration document by choosing the Save As command from the File 
menu; your keyboard choices become part of the configuration document. 
For more information on configuration documents, see Chapter 3, 
"Configuring MacDFT. • 
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The keyboard provides on-line help for using the keyboard. Select the 
Keyboard Help button from the Keypad dialog box. The Help screen in 
Figure 5-4 appears. 

• Figure 5-4 Keyboard Help screen 
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Drag 3276 keycap to a Macintosh key 
or 

Select 3276 key by clicking and then click on a Macintosh key. 

Click on the selected key again. 

Drag Macintosh keycap to another Macintosh key. 

Drag Macintosh keycap to the trash can. 
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Using the keypad 
commands 

Using the keypad 

The keypad is a teat-off menu that enables you to send keystrokes without 
using the keyboard. You can create a customized keypad menu that contains 
the keystrokes you most frequently use, and tear if off to the corner of the 
window of your MacDFT session. The keypad configuration is shown in 
Figure 5-5. 

• Figure 5-5 MacDFT keypad 

D Keyped: Untitled - 1 

Function Keys Rutokeys 

-a. IRR$1 IRA$! -Ii I+- +l El RISH EOF INPUT 

Pftl PR2 
SYS CURSR 

ENTER CLEAR ATTN REQ $EL TEST 

PF! PF1 PF3 PF4 PFS PF6 PF7 PFB PF9 PFIO PF!l Pfl2 

PFl3 PFl4 PFIS PF16 PF!? PFIB PFl9 PF20 PF21 PF22 PF23 Pr.!4 

~ cUHR CURSR 
MINK PfllSE CRPDS 

rl' 
FIELD +- -+ t + *- .... ~ DUP MARK 

Your Keyped: Keypad: Untitled - I 
I Help I 

IRR$1 ERASE 
RESET -a. EOF INPUT -Ii I+- +l El 

Pftl PR2 
SYS CORSR [ H1~u1~rt tn Si!t><HI I 

El1TER ClEflR ATTN REQ $EL TEST 

PF! PF2 PF3 PF4 PFS PF6 PF7 PFB PF9 PflD PF!l Pfl2 I Cleor Keypad I 
PFl3 Pfl4 PFIS PF16 PFl7 PFIB PFl9 PF20 PF21 PF22 PF23 Pr.!4 

ALT CURSR 
I[ B ~ CURSR BLINK PAUSE CRPOS ).~UH~ 

FIELD t + I rr DUP M"K +- -+ *- .... 
( Cancel l 121 

Clicking a key from the keypad produces the same result as pressing the key 
on your Macintosh keyboard, including the playback of any Autokey item 
that you assigned to the keypad. 
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Mapping a command on 
the keypad 

Creating a customized 
keypad 

Saving your customized 
keypad 

MacDFf lets you customize your own keypad by mapping 3270 function 
keys to the bottom keypad shown in Figure 5-5. To map a function from the 
Keypad menu, select the function by clicking it. Then, click any pad on the 
keypad. After saving the keypad, you can execute the function you have 
mapped by selecting it from the keypad. You save the keypad to which you 
have mapped functions by using the Save or Save As command from the File 
menu. To delete a function from the keypad, click the function and drag it to 
the trash can. 

If you have created Autokeys with the Autokey menu, you can assign them 
to the Keypad. Select an Autokey item from the scrolling Autokey list, and 
click the new keypad where you want to place the Autokey. See Chapter 4 for 
more information about Autokey functions. 

You can customize a keypad to contain the functions you use most 
frequently. Choose the New command from the Keypad menu. Assign the 
keys and Autokey items that you use frequently and save the customized 
keypad with a name. You can use the size box to resize your customized 
keypad. Figure 5-6 shows an example of a customized keypad. 

• Figure 5-6 A customized keypad 
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When you have made all your keypad selections, click the Save button to save 
your choices. If you have made choices that you do not want to save, click 
either the Cancel or Revert to Saved button. This causes the keypad to revert 
to the last-saved keyboard settings. You can also save your choices into a 
configuration document by choosing the Save command from the File menu. 
Your keyboard choices become part of the current configuration document. 
For more information on configuration documents, see Chapter 3, 
"Configuring MacDFf." 
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The Keypad provides on-line help for using the keypad. Click the Keypad Help 
button on the Keypad dialog box. The Help screen in Figure 5-7 appears. 

• Figure 5-7 Keypad Help screen 
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c H A p T E R 6 

Transferring Files 

HE MACINTOSH AND THE IBM HOST RUNNING THE VM/CMS OR MYS/TSO 

operating system can share files through file transfer. Unlike copying and 

pasting, discussed in Chapter 4, file transfer lets you copy complete files 

between the Macintosh II computer and the IBM host. File transfer consists 

of two parts: configuring your choices for file transfer and executing file 

transfer commands. This chapter describes both parts of the file transfer 

process. 
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Configuring file transfer 

The File Transfer command in the Configure menu lets you choose the 
direction for file transfer and the operating environment, either VM/CMS or 
MVS/TSO. You can either upload files from the Macintosh to the host 
running VM/CMS or MYS/TSO, or download files from the host to the 
Macintosh. 

Figure 6-1 shows File Transfer command configuration options. These 
options are discussed in the next section. 

After you have configured file transfer, all subsequent file transfers follow 
the choices you have made, until you choose the File Transfer command 
again. If you want to transfer another type of file, choose the File Transfer 
command from the Configure menu again, and choose the appropriate 
configuration for your next file transfer. 

• Figure 6-1 File Transfer command 
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Selecting configuration 
choices 

6 Important 

Because VM/CMS and MVS/fSO are different operating systems, each has 
different parameters that you must specify before transferring files 
between the host and the Macintosh. MacDFT supplies you with default file 
transfer parameters that are described in the section that follows. Each File 
Transfer configuration dialog box displays a different set of these file 
transfer parameters, depending on the file transfer direction, the file transfer 
mode, and the operating system. Unless otherwise stated, a parameter 
applies to both host environments. 

You can change these values, but be sure that the host accepts the values 
you are selecting. If you are not sure what values the host accepts, check 
with your system administrator. When you upload a file that replaces or 
appends an existing file, you must specify the same configuration 
parameters as the existing file. 6 

• Transfer Mode 

o Text Use this option for files that contain Text only (ASCII 
characters only). Before uploading a file as a Text file, save it as "text 
only"; formatting information such as bold or italic is not transferred 
to the host. 

o Binary Use this option for files that contain non-ASCII characters. 
Binary files cannot be transferred as Text files. Text files, however, 
may be sent as Binary files. 

o MacBinary Use this option only for Macintosh-created files that you 
want to use on a Macintosh. MacBinary transfer preserves all the 
Macintosh-specific information needed by the Macintosh file system. 

•> Note: Text and binary file transfer modes do not preserve information 
needed by the Macintosh file system. 

• Other Option 

o CR is record separator If you click this option, MacDFT software 
uses a carriage return (CR) as the record separator This option works 
only for text files. 

o Append CR to each line If you click this option, MacDFT uses a 
carriage return (CR) as the record separator. This option works only for 
text and binary files. 
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o Append to Host File If you click this option, MacDFT appends this 
file to the already existing host file named in the upload configuration 
dialog box. This option works only on text and binary files. 

• Overwrite Option You can choose whether you want the file you are 
transferring to overwrite an existing file with the same name. Choose one 
of the following. 

o Append to existing Macintosh file If you click this option, 
MacDFT attaches this file to the named file in the "download" dialog 
box for text and binary files. 

o Append to host file If you click this option, MacDFT attaches this 
file to the file you type in host filename text box. 

• Record Format 

o Fixed This option indicates that all records in the file have the same 
fixed length. 

o Variable This option indicates that the records in the file do not 
have the same length. A length field is available at the beginning of 
each record. 

o Undefined This option indicates that the file is not record oriented, 
and therefore does not have any length attributes. 

• CMS file mode The file mode is split into two components, a letter and 
a number. The letter specifies the virtual disk on which the file is to be 
located: A is the primary disk, and is the default. The number signifies the 
access type: 1 is read/write, and is the default. List your file and type in 
the value for the file mode, if it is not Al. 



• TSO Allocation You can change the value for TSO allocation and 
override the default allocation. Check with your system administrator for 
the appropriate range of values. You can specify space in tracks, block, or 
cylinders. Type the new values in the text box for primary and secondary 
space for TSO allocation, where primary and secondary are appropriate 
values for your host, as shown below. 

space(qty,incr) [AVBLOCK(value) ITRACKSICYLINDERS] 

This command specifies the amount of space to be attached for a new 
file. Use qty and incr to specify the amount of primary and 
secondary allocations. The smallest quantity of space is A VBLOCK, the 
medium quantity is TRACKS, and the largest quantity is CYLINDERS. If 
you don't specify the TSO allocation option, TSO uses default values. 

• Record Size Record size indicates the record size for the IBM file. The 
default for text files is 80 bytes; the default for binary or MacBinary files 
is 256 bytes. To change these values, type in the desired value for record 
size in the text box. 

• Block Size Block size refers to the block size of the IBM file. The 
default is 800 bytes. 

After you have made your selections, click OK. If you change your mind, click 
Cancel. To begin file transfer, use the Transfer Files command in the File 
menu. 
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Configuration for uploading a file to a host running MVS/TSO 

Figure 6-2 shows the dialog box that you see when you choose the TSO 
Upload command from the File Transfer pop-up menu. 

• Figure 6-2 "TSO upload configuration" dialog box 
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After you have made your choices, click OK. 



Configuration for uploading a file to a host running VM/CMS 

Figure 6-3 shows the dialog box that you see when choose the CMS Upload 
command from the File Transfer pop-up menu. 

• Figure 6-3 "VM/CMS upload configuration" dialog box 
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After you have made your choices, click OK. 
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Configuration for downloading a file from a host running 
MVS/TSO 

Figure 6-4 shows the dialog box that you see when you choose the TSO 
Download command from the File Transfer pop-up menu. 

• Figure 6-4 "TSO download configuration" dialog box 
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After you have made your choices, click OK. 



Configuration for downloading a file from a host running 
VM/CMS 

Figure 6-5 shows the menu that you see when you choose the CMS 
Download command from the File Transfer pop-up menu. 

• Figure 6-5 "VM/CMS download configuration" dialog box 

UM/CMS Download 

Transfer Mode ® TeHt 

QBinary 

O MacBinary 

01Jerwrite Option 181 Rppend to eHisting Macintosh file 

CMS File Mode ~ 

( Cancel ) n OK B 

After you have made your choices, click OK. 
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Transferring files 
To execute ftle transfer, choose the Transfer Files command from the File 
menu. You must be logged on to the host, and the Ready prompt must be 
displayed. You cannot use any host application while transferring files. 

+ Note: Because of the way data is stored and formatted on the Macintosh, 
some reformatting of text files is necessary after a file is uploaded to the 
host. 

Choosing the Transfer Files command from the File menu brings up the "File 
transfer" dialog box, shown in Figure 6-6. 

• Choose the host operating environment Click either TSO or CMS. 
You must be sure that the host operating environment you choose 
matches the host to which you are logged on. The default operating 
system is the one you most recently configured in the File Transfer 
command in the Configure Menu. 

• Figure 6-6 "File transfer" dialog box 

FT for Macon 1.0 

3270 File Transfer Protocol 

Messages 

To invoke File Transfer. choose either TSO or CMS, and 
then click Upload (to Host) or Download (from Host)_ 

IBM Host @TSO QCMS 

Upload (oownload) Cancel 



• Choose the direction for file transfer Click either Upload or 
Download to go to the next dialog box for file transfer. The "Upload" 
dialog box is shown in Figure 6-7; the "Download" dialog box is shown in 
Figure 6-8. 

Figure 6-7 shows the dialog box that appears when you click the Upload 
button in the "File transfer" dialog box (shown in Figure 6-6). This example 
shows a listing of files that can be uploaded to the host. 

Follow these directions to upload a file: 

1. Type the host filename and file type in the text box. 

2. Select the folder from which the file will be uploaded. Figure 6-7 shows 
the files that can be uploaded from the special projects folder. If you 
want to choose another folder, click the text box for folders to choose 
the folder you want. 

3. Click the Macintosh filename in the list. 

4. Click the Upload button to start the file transfer. If you click Cancel, you 
return to terminal emulation. 

/::;;. Important If you are uploading a file to a VM/CMS host, you must specify the filename 
and file type. If you do not specify the file mode, the default file mode, Al, is 
used. Files to be uploaded cannot be in use. 6 

• Figure 6-7 "Upload" dialog box 

la special projects I 
O announcements 1'!1 
D artisans 
D entertainment 
D phones 
D sites 

Host file name 

=home 

Driue 

Upload 

Cancel 
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Figure 6-8 shows the dialog box that appears when you click the Download 
button in the "File transfer" dialog box. 

Follow these directions to download a file: 

1. Type the Macintosh filename in the upper text box. You can either type 
over the "Copy of' portion of the upper text box, or type after the words 
"Copy of" to name the file that you are downloading. 

2 Type the host filename in the lower text box. 

3. Choose the folder to which the file will be downloaded. When you 
download a file, the file is placed in the folder shown in the dialog box, 
above the file listing. If you want to choose another folder, click the text 
box for folders to choose the folder you want. 

4. Click the Download button to start the file transfer. If you click Cancel, 
you return to terminal emulation. 

!:::,. Important If you are downloading a text file, it will be stored on the Macintosh as a 
MacWrite file. D. 
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• Figure 6-8 "Download" dialog box 

la projects I 
Cl artisans 
Cl entertainment 
Cl phones 
Cl sites 

Saue File as: 

I copy o~ 

Host file name 

=home 

E:jt~ct 

Driue 

(Download] 

Cancel 



The dialog box shown in Figure 6-9 appears after you have clicked either the 
Upload or Download button. It shows the "File transfer" dialog box with 
the filenames for the host and Macintosh files, and the file transfer status 
displayed in the Messages area. 

6. Important The "Transfer mode" field shows Text. If you want to transfer the file as a 
binary or MacBinary file, you must click the "Abort transfer" button and 
return to the File Transfer command in the Configure menu. If you choose 
the "Abort transfer" button, MacDFT leaves file transfer and returns to 
terminal emulation. 6 

• Figure 6-9 Beginning file transfer 

FT for MacDFT 1.0 

3270 File Transfer Protocol 

Host File Name 

Macintosh File 

Tnmsfer Mode 

test.a 

prtfile 

Te Ht 

# of Bytes Transferred 902 

Messages 

Uploading in progress 

( Rbort transfer ) 
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Figure 6-10 shows the "File transfer" dialog box with the message that the 
ftle transfer is in progress. The dialog box also will display the number of 
bytes that have been transferred. 

• Figure 6-10 File transfer in progress 

FT for Macon 1.0 

3270 File Transfer Protocol 

Host File Name test.a 

Macintosh File prtfile 

File Type Chosen TeHt 

# of Bytes Transferred 

Messages 

lnuoking file transfer on the host 

( Abort transfer J 



Figure 6-11 shows the "File transfer" dialog box when file transfer is 
complete. The dialog box displays the number of bytes that have been 
transferred and any informational or error messages. Error messages are 
listed in Appendix B. 

If you are finished transferring files, click Done. If you want to transfer 
another file, click Upload or Download. 

• Figure 6-11 Completed file transfer 

FT for MacDFT 1.0 

3270 File Transfer Protocol 

Host File Name test.a 

Macintosh File prtfile 

File Type Chosen TeHt 

# of Bytes Transferred 902 

Messages 

Uploading file completed successfully 

IBM Host @TSO QCMS 

Upload [Download] Done 
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A p p E N D x A 

Reading the Status Line 

THE STATUS LINE AT THE BOTI'OM OF THE TERMINAL EMULATION SCREEN 

displays messages from the host and control unit. These messages tell the 

status of the host, control unit, and applications that you are running. 

This appendix shows some of the status line messages most frequently seen 

while using MacDFT, but does not cover all of the possible messages. IBM 

documentation provides a comprehensive description of these messages and 

of problem resolution. If you do not understand status line messages, ask 

your system administrator for assistance. 
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The status line is displayed at the bottom of your Macintosh screen when 
your Macintosh is connected to a control unit. The status line displays 
Operator Information Area COIA) messages about the host or control 
unit to which your Macintosh is connected. This information appears as 
symbols, numbers, and letters. Figure A-1 shows a MacDFT terminal 
emulation screen with OIA messages in the status line. 

• Figure A-1 MacDFf screen with OJA symbols 

Macon 1.0 

I 
I 

OJA symbols in the status line -----+5:-;-;:-x E_H_TE_R _k·--~_fo_r_l_i •_t _o_f _oP_Pl_i c_ot_i o_n_• --------1 
<:i [ Jmmrn:m:~:::m~i:::::::::m:::1::::::~::::::::rn;::::i::::mimm;.:i:i:i~i::::mi:i:i::::mi:m:rn;::~1i:~1ii1:m~1~rn:1:i~1:1::mw~~m:i:::i:~:~1;:mt~i@i!im~imm~1 Ql'2l 

The symbols sent by the IBM host are shown in Table A-1. Status line 
messages are made up of one or more OIA symbols that read from left to 
right. 
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• Table A-1 OIA symbols 

Symbol 

)( 
f.:_"; .... 
D 

I 

TEST 

Message 

Means do not enter (input inhibited) 

Means time is required 

Represents a display unit or printer 

Signifies a malfunction 

Signifies a connection 

Signifies that your Macintosh computer is connected to 
your application program 

Signifies that your Macintosh is connected to your system 
operator (control program) 

Signifies that your Macintosh is connected to the host 
system, but that your application program or control 
program is not connected 

Occurs when the TEST key is pressed, and indicates that 
the Macintosh is in TEST mode from the host 

The section that follows gives examples of status messages, classified by 
type. 

Readiness and system connect messages 

The readiness and system connection symbols are displayed in the first six 
character spaces in the status line. These symbols are used singly or in 
combinations to indicate the readiness of your Macintosh, control unit, or 
host. 
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Control unit ready symbols 

These symbols indicate that the control unit to which your Macintosh is 
connected is ready for operation. An S indicates that your Macintosh is 
connected to a 3174 control unit. A ~indicates that your Macintosh system 
is connected to a 3274 control unit. 

On-line symbols 

ei or~ A Ready symbol must be displayed on your screen before an A or a Ji (on-line 
symbols) can be displayed. These symbols tell you that the Macintosh is 
connected (on line) to the host. 

If your display is attached and on line to the control unit, the on-line symbol is 
displayed to tell you which of two sets of rules governs your transactions 
with the host. Certain keyboard functions and the meanings of some OIA 
symbols differ, depending on which set of rules is governing. A indicates that 
your Macintosh is attached to a control unit that is not running SNA, and Ji 
indicates that your Macintosh is attached to a control unit that is running SNA. 

The on-line A symbol turns off when you perform any action at your 
Macintosh that requires a response from the host system. When the host 
system responds, the A turns on again. Whether or not the off/on action is 
apparent depends on how busy the host system is and how quickly it 
responds. 

"Do not enter" messages 

Do not enter (input inhibited) 

)( The X ("do not enter") symbol tells you that your host will not accept input 
from your keyboard. Additional symbols are always displayed to the right of 
the X to define why your keyboard is inhibited. 

When the "do not enter" message appears, your host will not accept data 
from your keyboard. The reasons why the "do not enter" message comes on 
are discussed in the descriptions that follow. Each description also tells you 
how to tum off the "do not enter" message and restore your keyboard. 
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)( r'.:;; .... 

)( ~}+? 

Wait 

The host needs more time to perf onn the function you requested. You must 
wait for the function to be completed. 

Try it again 

All or part of the last operation that you tried was not accepted by your 
Macintosh. Check your MacDFf window to make sure that the operation 
you want to perfonn is correct, press the RESET key to restore your 
keyboard, and try the operation again. Do not try to type while the X symbol 
is displayed. 

System lock 

)( S V STEM The host has disabled your keyboard after processing your entry. The host 
may send you a message on your Macintosh, explaining the reason for 
disabling your keyboard. You can either wait for the host to restore your 
keyboard, or press the RESET key to restore your keyboard. You can access 
the RESET key from the keypad or the keyboard. 

Go elsewhere 

)( +;::+ You have tried to take an action in the wrong location, such as 

• entering, inserting, erasing, or deleting a character when the cursor is in a 
protected field 

• perfonning a cursor-select operation when the cursor is not in a valid 
cursor-select field 

To restore your keyboard, press the RESET key, then move the cursor to 
another position or take a different action. 

Too much data 

)( * > You have entered more data into a field than it can hold. Press the RESET key 
to restore your keyboard; then correct the entry. 
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Numeric data only 

XNUM You have entered a nonnumeric character, other than 0 through 9, the DUP 
key, the period(.), and the minus sign(-), into a numeric field. Press the 
RESET key to restore your keyboard; then enter numeric data. 

What number? 

)( * # Only certain numbers can be entered for the operation you are performing. 

X-f 

@JAorSA 

·~ 

Press the RESET key to restore your keyboard; then enter the correct number. 

Minus function 

The function or operation that you requested is unavailable. Press the RESET 
key and check the OIA for other symbols to determine if the function is 
permanently or temporarily unavailable. Here are some examples: 

• If either of these sets of symbols is displayed, the function is 
permanently unavailable. Press the RESET key to restore your keyboard; 
then take other action. 

• If either of these sets of symbols is displayed, the CURSR SEL, ATIN, PA, 
and PF keys are nonfunctional at this time. Press the RESET key to 
restore your keyboard, then take other action. 

• If this symbol is displayed and and none of the above symbol 
combinations is displayed, the function is temporarily unavailable. Press 
the RESET key to restore your keyboard, and try the function again. 

Communication Check 

)(--3v__ nn or nnn There is a problem with the communication line between the control unit and 
the host system. The error number nn or nnn defines the type of 
Communication Check. For example, the number 505 indicates that the 
control unit is not working. Press the RESET key to restore your keyboard, 
and try again. This message is in the first six character positions in the status 
line. If you see these symbols in character position 21 of the status line, the 
message indicates a Communication Reminder message. See your system 
administrator if this message persists. 
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)( PROG nn or nnn 

Program Check 

The control unit detected a programming error in the data received from the 
host. The error number nn or nnn defines the type of Program Check. Press 
the RESET key to restore your keyboard, and continue. If the problem 
persists, consult your system administrator. 

Mode symbols 

MacDFT displays two mode symbols: 

• numeric lock 

• insert 

Numeric lock 

NU M This symbol appears when you select Numeric Lock through the Display 
Settings command from the Configure Menu, and your cursor is in a host­
defined numeric field. NUM appears in the center of your status line. 

Insert 

This symbol appears when you select insert mode in your terminal emulation 
session. The IBM keyboard has an Insert key that can be used from the 
Macintosh keyboard; see Chapter 5 to learn how to map IBM keys to the 
Macintosh keyboard. The Insert Key message is located in the center of your 
status line. 
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MacDFf messages 

The Play and Play Pause messages appear on the status line during MacDFT 
sessions. 

Play 

p P indicates that a recorded message is being sent to the host. Examples of 
situations that cause the P message to appear include an Autokey string, text 
that is being pasted into a host session, or a key from the Keypad 

Play pause 

pp PP indicates that the Autokey is pausing while sending a recorded message. 
Use the Resume key in the Autokey menu to continue playing the Autokey 
sequence. 
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A p p E N D x B 

MacDFT Error Messages 

RROR MESSAGES COME FROM THE MACINTOSH COMPUTER, THE HOST, AND THE 

application that you are running. This appendix describes error messages that 

are generated by the MacDFT application. For information on messages from 

the Macintosh, or for general Macintosh troubleshooting information, see 

your Macintosh II owner's guide. For information on messages from the 

host, see your host documentation or your system administrator. Also, see 

Appendix A for status line messages from the host. 
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About MacDFf error messages 
MacDFT displays error messages in either an alert box or a warning box. The 
sections that follow contain strings of text that MacDFT displays in alert 
boxes. An alert box or warning can display one or more strings that explain the 
current situation and may suggest a solution. 

Alert boxes notify you whenever an unusual situation occurs. Alert boxes 
inform you about choices you can make, given the situation. For severe 
problems, messages are placed in warning boxes . 

Figures B-1 and B-2 show examples of alert and warning boxes. Note that the 
alert box contains a triangle surrounding an exclamation point(!), whereas the 
warning box contains the stop-sign octagon with a hand in the "Stop!" 
position. 

The alert box in Figure B-1 lets you choose whether to install changes and 
reset the terminal. 

• Figure B-1 Alert box example 

To install the changes, the 
terminal must be reset. Do 
you wish to proceed? 

No n Yes D 

Figure B-2 shows a warning message. It informs you about a situation and 
forces you to acknowledge it by clicking the OK button. 
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Incorrect password 

Password is too long 

Password confirmation failed. 
Please try again 

Driver cannot be opened 

Host session cannot be established 

• Figure B-2 Warning box example 

There is no 3270 adapter in 
your system. Macon cannot 
proceed. 

€ OK D 

Password error messages 

You have typed your password incorrectly. Please try it again. See Chapter 3 
for more information about passwords. 

You have typed a password with too many characters. You can use up to 16 
characters for your password. See Chapter 3 for more information about 
passwords. 

You have typed your password incorrectly. Please try it again. See Chapter 3 
for more information about passwords. 

Hardware error messages 

Make sure that your application is installed correctly. See Chapter 2. 

Check with your system administrator if the host and control unit are on line. 
Make sure that your coaxial cable is attached to your Coax/Twinax card. See 
Chapter 2 for information about how the cable should be attached. 
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There is no 3270 adapter in your 
system. MacDFf cannot proceed 

Please check theMacDFf User's Guide 
for the required configuration 

Duplicate or reserved keyboard 
equivalent 

You need a Coax/Twinax card to use MacDFT. If you have a card, make sure it 
is properly installed. See Chapter 2. 

Configuration error messages 

This message appears when you do not have the correct hardware and 
software to run MacDFT. See "What You Need to Get Started" in Chapter 1. 

The Macintosh has assigned this key as a reserved keyboard equivalent. 
Choose another keyboard equivalent. 

A name may not begin with a space or An Autokey name cannot contain these characters. 
contain characters ";"</(" 

Please do not use the names of 3270 
control keys for your Autokey 
strings: they are reserved 

Too many resources 

MacDFf configuration files cannot 
be printed. Use Open or New 
command in the File menu to open a 
configuration document 

Cursor cannot be positioned here 
because the default screen size has 
been set by the host 

Do not use names like DUP, PFl, or PA2. These names are reserved. You can 
use the functionality of these keys through the keypad or the keyboard. 

You can have only 43 keypad menus. 

You cannot print configuration documents. If you want to see the 
information in them, use the Open command in the File menu to open a 
configuration document. 

You have clicked or pointed outside of the space currently available to the 
terminal. Move your cursor. 
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Error writing me to host: File 
transfer canceled 

File transfer canceled 

Host timeout occurred 

Insufficient memory space 

Checksum error 

Closing local me error 

Creating local file error 

File transfer error messages 

Try file transfer again. See Chapter 7 for more information on file transfer. If 
this problem persists, check with your system administrator. 

Try file transfer again. See Chapter 7 for more information on file transfer. If 
this problem persists, check with your system administrator. 

Try your command again or call your system administrator. If this problem 
persists, check with your system administrator. If you click OK, then press 
the Enter key, you may see a host-generated message explaining the timeout. 

There is not enough memory on your Macintosh. Close other applications 
before using the File Transfer command. 

Cancel the File Transfer command, then try again. If this problem persists, 
check with your system administrator. 

Cancel file transfer and try again. If this problem persists, check with your 
system administrator. 

Cancel file transfer and try again. If this problem persists, check with your 
system administrator. 
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A p p E N D x c 

Supported Environments 

M Aci)Ff EMULATES THE 3270 FAMILY OF IBM TI!RMJNAIS. TIDS APPENDIX 

lists tenninals that MacDFT emulates, and supported hosts and control 

units. 
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Emulated terminals 

Table C-1 lists IBM display terminals that your Macintosh running MacDFT 
can emulate. 

• Table C-1 Tenninals that your Macintosh running MacDFT can emulate 

Terminal type Model numbers 

3278 monochrome 2,3,4,5 

3279 Model 2 or 3 S2A, S2B, S3A, S3B 
Base and extended color 

3178 monochrome C3 

3179 Model 1, seven color 2 

Note: Each terminal has an 87-key typewriter keyboard a with numeric keypad. 

Supported host and control units 

MacDFT supports IBM S/370 architecture machines, running MVS/XA, 
MYS/SP, or VWSP. The Macintosh running MacDFT software can attach to 
the 3174 or 3274 control unit Category A devices. Table C-2 shows the 
supported control unit configuration for MacDFT. 

• Table C-2 Control unit configuration 

Control unit 
model 

3174 
3274 
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Configuration 
support 

A 
D 

Microcode 
release 

2orhigher 
65orhigher 



Glossary 

alert box: A type of dialog box that appears on the 
screen when the user is in a crucial situation or is about 
to make a crucial decision. An alert box can warn of 
dangerous situations, recommend corrective actions, or 
provide information that might change the user's plans. 
See also dialog box. 

Apple Real-time Operating System Environment 
(A/ROSE): A process that provides message passing 
between the Coax/Twinax card and the main logic board 
of the Macintosh II. 

Autokey: A feature of MacDFf that lets the user create 
strings of text, or keystrokes, that the user can play in 
the same sequence by pressing an assigned keyboard­
equivalent key, or by choosing the Play command in the 
Autokey menu. 

button: A small screen object, usually labeled with text. 
Clicking a button performs the action described by the 
button's label. 

check box: A special kind of button that indicates 
whether a certain option is on or off. The option is on 
if the box is checked, off if it is not. Check boxes 
appearing together in the same context are independent 
of each other; any number of boxes can be checked or 
unchecked. 

click: The action of pressing down the mouse button 
and quickly releasing it while the mouse remains 
stationary. 

coaxial cable: One type of medium used to connect a 
terminal to a control unit. 

coaxial connector: The part of the Coax/Twinax card 
that connects to the coaxial cable. 

color wheel: A large on-screen item that appears when 
you click the Change Color button after selecting the 
Color icon in the Control Panel or Display Settings dialog 
box. By clicking on a portion of the color wheel, you can 
change the highlight color for your screen. See also icon. 

Control Panel: A desk accessory that allows you to 
change certain basic characteristics of the Macintosh 
interface, such as the desktop pattern, the volume level, 
and the key repeat rate. 

control unit: A peripheral node that can control a 
variety of devices. 

Control Unit Terminal (CUT): A mode of IBM 
terminal emulation that runs one session. 

dialog box: A window-like box that contains a 
message requesting more information from the user. 
Although dialog boxes appear in many different 
situations, they always appear when the user chooses a 
menu item that is followed, in the menu itself, by 
ellipses( .. .). 

dim.med: When words or icons appear in gray, they are 
dimmed. Menu items are dimmed when they cannot be 
chosen; folder icons are dimmed when they are open. See 
also icon. 

Distributed Function Terminal (DFT): A mode of 
IBM terminal emulation that runs up to five sessions. 

download: To transfer a file from the host to the 
Macintosh. 

drag: The action of placing the pointer on an object by 
using the mouse, pushing down the mouse button, 
moving the pointer to a new location on the screen, and 
releasing the mouse button. 
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error message: A message displayed or printed to tell 
you of an error or problem in the execution of a program 
or in your communication with the system. An error 
message often appears in the form of an alert box, and is 
often accompanied by a beep. 

expansion card: A circuit board that implements 
specialized functions not otherwise supported by the 
computer. 

field: A subdivision of a record, usually consisting of a 
single item of information related to the rest of the 
record. 

host application: An application that runs on the 
host computer. 

host computer: A multi-user computer, such as a 
minicomputer or mainframe, that serves as a central 
processing unit for a number of terminals. See also 
mainframe. 

IBM 3270 Information Display System: See model 
2-S terminal 

icon: An image that graphically represents an object, a 
concept, or a message. Screen icons in mouse-based 
applications represent disks, documents, application 
programs, or other things you can select and open. 

launch: To put a program into action; to initiate a 
program. 

mainframe: A large computer, generally with a high 
level of processing power and the capacity to support 
many users at once. 

model 2-S terminals: The different models of the 
IBM 3270 Information Display System. Each model 
displays a different configuration of rows and columns. 

MVS/TSO: An IBM host operating environment. 

NuBus: An address bus and data bus incorporated into 
the system architecture of the Macintosh II. The NuBus 
architecture lets you add a variety of components to the 
system, by means of expansion cards installed in NuBus 
expansion slots inside the Macintosh II. 
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Operator Information Area (OIA): In the IBM 3270 
Information Display System, the area near the bottom 
of the display area where terminal or system status 
information is displayed in symbols. This area is also 
called the status line. See also IBM 3270 Information 
Display System. 

parameter: A value passed to or from a function or 
other routine. 

scroll bat: A scroll bar is a light gray rectangle having on 
each end an arrow in a square box. Vertical scroll bars are 
on the right side of the associated document, while 
horizontal scroll bars run along the bottom of the 
window. 

security lock mechanfsm: A lock-and-key mechanism 
on an IBM 3278 terminal that allows the user to prevent 
others from using it. 

select: To designate where the next action will take 
place. To select by using a mouse, you click an icon or 
drag across information. See also click, drag. 

session: A data "conversation" between two devices on 
a network. 

size box: The box in the lower-right comer of a 
window that the user can drag in order to enlarge or 
reduce the window. 

status line: The line at the bottom of the MacDFT 
terminal emulation screen that displays OIA messages. 
See also Operator Information Area (OIA). 

Systems Network Architecture (SNA): A set of 
communication protocols developed by IBM for 
transmission of data. A key purpose of SNA is to allow 
different types of terminals and devices to 
communicate over a network. 

tear-off menu: A menu that the user can "tear" from 
the menu bar and move around the screen like a window. 

terminal emulation: Software that allows a personal 
computer to communicate with a host computer by 
transmitting in the form used by the host's terminals. 
See also host computer. 



text box: A place in a dialog box in which you type text. 

trash can: An icon that initially appears in the lower­
right comer of the desktop. You can remove files, 
folders, and applications from storage media by 
dragging their icons into the trash can. 

upload: To transfer a file from the Macintosh to the 
host. 

VM/CMS: An IBM host operating environment. 

Glossary 91 





THE APPLE PUBLISHING SYSTEM 

The MacDYT User's Guide was written, 
edited, and composed on a desktop 
publishing system using Apple® 
Macintosh® computers, an AppleTalk® 
network system, and Microsoft® Word. 
Proof pages were created on the Apple 
LaserWriter® printers; final pages were 
printed on a Varityper® VT600™. Line 
art was created using Adobe Illustrator™ 
and typeset on a Linotronic® 300. 
Postscript®, the LaserWriter page­
description language, was developed by 
Adobe Systems Incorporated. 

Text type and display type are Apple's 
corporate font, a condensed version of 
ITC Garamond®. Bullets are ITC Zapf 
Dingbats®. Some elements, such as 
program listings, are set in Apple 
Courier, a fixed-width font. 



Apple Computer, Inc. 
20525 Mariani Avenue 
Cupertino, Otlifornia 95014 
( 408) 996-1010 
TIX 171-576 

030-3263-A 
Printed in U.SA. 


